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C h a p t e r

1

About Dynamic Views

Dynamic Views consists of the following modules that run under DM 
Extensions:

Dynamic Views

Dynamic Views lets users customize folder views in DM Extension for 
Windows Explorer, the Quick Retrieve dialog box, and DM Extension 
for Microsoft Outlook. Dynamic Views has two default tree views: My 
Favorite Matters and My Recent Matters. You can further customize the tree 
view by selecting additional search objects to be displayed in the tree 
view. For more information on Dynamic Views, see “Dynamic Views” 
on page 17.

DM Extensions Dynamic Profiling

Users can easily profile documents using DM Extensions Dynamic 
Profiling. A user can profile documents by using personal profile 
defaults or group level defaults, or by selecting individual values from 
the table lookups on the profile form. DM Extensions Dynamic 
Profiling allows the user to profile documents by selecting a folder in 
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the virtual folder structure that is based on the standard profile form 
fields. The addition of the dynamic Profile tab allows the user to toggle 
between the virtual folder structure view and the standard profile form 
view. For more information on Dynamic Profiling, see “DM Extensions 
Dynamic Profiling” on page 31.

You can also create Ad Hoc folders and sub-folders in DM Extensions 
Dynamic Profiling and Dynamic Views. You can create Ad Hoc folders 
at any level of the dynamic folder structure. Fore more information on 
Ad Hoc Folders, see “Ad Hoc Folders” on page 26.

DM Dynamic Views & Profiling Configuration Utility

This utility enables the DM administrator to define the tree structure 
appearance in Dynamic Views and Dynamic Profiling. You can also 
define the labels and messages that will be displayed to users, and define 
whether users can set security on documents and create folders. For 
more information on using the utility, see “Using the DM Dynamic 
Views and Profiling Configuration Utility” on page 39.

Matter-Centric Security

Matter-Centric Security allows you to define security for a specific 
matter, which is then applied to each document stored within. For 
example, when you drag and drop a document onto a matter using 
Matter-Centric Security, that document inherits the already-defined 
security. Delegates, such as paralegals or secretaries, can define which 
users and groups are granted access to a particular Matter, instead of 
having to apply security to each document. For more information 
about Matter-Centric Security, see “Matter-Centric Security” on page 
63.
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C h a p t e r

2

Installing Dynamic Views

This chapter, which explains how to install and configure Dynamic 
Views, consists of the following sections:

• Installing DM Dynamic Profiling

• Installing DM Dynamic Views

• Installing DM Dynamic Views & Profiling Configuration Utility

• Post-Installation Steps

• Implementing Matter-Centric Security
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Prerequisites for Installation

• The following software must be installed prior to installing 
Dynamic Views:

The 5.1.0.5 SR6 version of DM Server and DM 
Extensions Server Setup. 

The 5.1.0.5 SR6 version of DM Extensions on user 
workstations. This is installed from the 5.1.0.5 SR6 DM 
Extensions Server Setup or from DM Webtop by 
selecting My Options>Optional Components. 

• Before you run the Dynamic Views installation program, 
you must download the Dynamic Views package from the 
Hummingbird Web site and run two SQL script files against 
your DM database to add supporting tables and 
information. See “Download and Run the SQL Script Files” 
on page 8.

• The DM Dynamic Views & Profiling Configuration Utility 
enables the DM administrator to set up the DM Dynamic 
Views/DM Dynamic Profiling capabilities for end users. 
Install the configuration utility on the administrator’s 
machine. It is not necessary for this module to be installed 
on end user workstations. In addition, DM Dynamic Views 
and DM Dynamic Profiling must be installed on the same 
machine as the configuration utility. 

Download and Run
the SQL Script Files

To download the software:

1. Download Dynamic Views to a network location and unzip 
the files.

2. Double-click dvdp.exe to run the installation program. The 
program asks for a network location where the files can be 
copied and places the files in the folder you indicate. 

To run the SQL script files:

1. Navigate to the folder where the files were copied. By 
default, the files are copied to C:\Program 
Files\Hummingbird\Enterprise 2004 Service 
Releases\Service Release 6\DVDP.

2. Locate the two SQL script files in the \Scripts folder:

dvdp_tables_create.SQL
8  CHAPTER 2



legal_inserts.SQL

Oracle:

dvdp_tables_create_ORA.sql

legal_inserts.sql

3. If the SQL login account for your DM library is an account 
other than the default account (DOCSUSER), you will need 
to modify the script file that creates the database tables 
(dvdp_tables_create.sql). Change all references to 
DOCSUSER to the name of your SQL login account.

4. Run the two SQL script files in the \Scripts folder against 
your DM library.

Microsoft SQL Server or Sybase Adaptive Server 
environments: 

a. Run Query Analyzer, load the file 
dvdp_tables_create.SQL, select the DM database, and 
run the script file.

b. Run the file legal_inserts.SQL against the database.

Oracle environments: 

a. Modify the script files. The database owner is 
DOCSADM. If your Oracle database has a different 
owner, replace all instances of DOCSADM with the 
Oracle database owner name in the files 
dvdp_tables_create_ORA.sql and legal_inserts.sql.

b. Run Oracle SQL Plus, load the file 
dvdp_tables_create_ORA.sql, select the DM database, 
and run the script file.

c. Run the file legal_inserts.sql against the database.

Installing DM Dynamic Profiling

Open the folder \DM Dynamic Profiling and run the executable file 
setup.exe to install DM Dynamic Profiling. By default, the program is 
installed to C:\Program Files\Hummingbird\DM Dynamic Views. 
INSTALLING DYNAMIC VIEWS      9



Installing DM Dynamic Views

Open the folder \DM Dynamic Views and run the executable file 
setup.exe to install DM Dynamic Views. By default, the program is 
installed to C:\Program Files\Hummingbird\DM Dynamic Views. 

Installing DM Dynamic Views & Profiling 
Configuration Utility

The Configuration Utility should only be installed on the DM 
administrator’s machine. It should not be installed on user 
workstations. DM Dynamic Views and DM Dynamic Profiling must be 
installed on the same machine as the Configuration Utility. The three 
modules can be installed in any order.

Workstations using Dynamic Views Dynamic Profiling (DVDP) need 
to have both Dynamic Views and Dynamic Profiling installed on each 
workstation in order to utilize DVDP. 

You do not need to install anything on the Fusion servers, unless you 
want to use the Configuration Utility on that machine.

Open the folder \DM DVDP Configuration Utility and run the 
executable file setup.exe to install the Configuration Utility. By default, 
the utility is installed to C:\Program Files\Hummingbird\DM 
Dynamic Views. After installation, the utility can be accessed from 
Start>All Programs>Hummingbird>DM Dynamic Views & Profiling Configuration 
Utility.

Consult “Using the DM Dynamic Views and Profiling Configuration 
Utility” on page 39 for information on using the utility.

Post-Installation Steps

After you have run the installation programs detailed in the sections 
above, performs the steps in the section below. 

Ad hoc Folders If you plan to use Ad hoc Folders at your site, you must add the 
DV_FOLDERLEVEL (String 60) field to the folder profile form that 
has been specified as the default profile used to set up the Tree 
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Structure. Even if users only want to allow Ad hoc Folders on the lowest 
level, this field is mandatory. 

To add the DV_FOLDERLEVEL field:

1. On the DM Server, start DM Designer by clicking 
Start>Hummingbird>DM Server>Server Admin Tools>DM Designer.

2. Click the Database tab.

3. Highlight the Profile table.

4. Click the New Column button.

5. In the Column Name field type DV_FOLDERLEVEL.

6. In the Length field, type 60.

7. Leave all other fields at their default setting.

8. Click the OK button.

9. Close the database form and click on the Profiles tab. 

10. From the Available Forms window, select the default profile 
form for the DOCS_SUPERVISORS group. The 
DOCS_SUPERVISORS default profile form must be set as 
the default profile form for all users that are going to use 
Dynamic Views Dynamic Profiling.

If you want to use a different profile form, change the DOCS_SUPERVISORS  
profile form to the DOCS_USERS profile form to set up DVDP, and then revert 
to the original profile form. 

11. Select the DV_FOLDERLEVEL column in the SQL 
Columns menu and drag it to the Profile form.

12. Right-click the field and select Options>Hidden.

13. Select File>Save and exit DM Designer.

14. Refresh the cache on DM Server in order for the changes to 
be applied. 

The database is now set up to use Ad Hoc folders.

If you use a different profile form, such as one customized for Microsoft 
Outlook, you must add the DV_FOLDERLEVEL field to the profile 
form in order to create Ad Hoc folders from Outlook.

My Reminders
Search Object

The <My Reminders> search object returns a list of documents that 
have or will within seven days past a due date.
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To use this search object, the administrator must first configure the 
default Profile form by placing the DV_REMINDER field on the form. 
You must also configure the number of days that should pass after the 
due date.

Implementing Matter-Centric Security

In DM, the creator of a document can assign security to the document 
in the form of an access-control list (ACL), which is part of the 
Document Profile. The ACL lists the users and groups that can access 
the document and the level at which they can access (read only, write, 
etc.). 

The Matter-Centric Security feature in Dynamic Views gives members 
of the SUBSCRIPTIONS_MANAGER group (or a DM group given the 
Subscription Manager responsibility) the ability to grant—to specific 
users and/or groups—the rights to all documents in a Client/Matter, 
regardless of any one document’s ACL security. All documents related 
to the matter then appear in the user’s tree structure in DM Extensions. 

The Subscription Manager defines access rights at the matter level, 
which, for the selected users and/or groups, supersedes the ACL on the 
Profile. This matter-level security applies to all documents in the 
matter, except for those to which custom security has been applied. 

The granting of matter security is done in the DM Dynamic Views & 
Profiling Configuration Utility on the Tree Structure tab’s Inherited 
Security tab. To implement the Matter-Centric Security feature, you 
must install Dynamic Views and then modify the DM database:

• Add the CUSTOMSECURITY field to the folder Profile form that 
has been specified as the default Profile used to set up the tree 
structure. 

• Add two columns to the MATTER table.

• Add a DELEGATES table with three columns.

• Set up links from these new columns to the PEOPLE table. 

The following instructions explain how to modify the database.
12  CHAPTER 2



Modifying the
PROFILE Table

1.On the DM Server machine, start DM Designer 
(Start>Hummingbird>DM Server>Server Admin Tools>DM 
Designer).

2.Click the Database tab, highlight the Profile table, and click 
New Column. Then enter the following information and click 
OK:

2.1 In the Column Name field, type CUSTOMSECURITY.

2.2 In the Type field, select the integer option.

2.3 Leave all other fields at their default setting.

3.Close the database form and click the Profiles tab. In the 
Available Forms window, select the default Profile form for 
the DOCS_SUPERVISORS group.

4.Select the CUSTOMSECURITY column in the SQL Columns 
menu and drag it to the Profile form.

5.Right-click the field and select Options>Hidden.

6.Select File>Save and exit DM Designer.

7.Refresh the cache on DM Server to apply the changes.

Modifying the
MATTER Table

Create the RESP_PERSON column:

1.In DM Designer, click the Database tab, highlight the 
MATTER table, and click New Column. Then enter the 
following information:

1.1 In the Column Name field, type RESP_PERSON.

1.2 In the Type field, select the integer option.

1.3 In the Key? field, select Foreign.

1.4 In the Link field, use the ellipses button to display a list 
of available tables to link to.

1.5 Highlight the PEOPLE table and click OK.

1.6 Verify that the link to the PEOPLE table is now in the 
text box.

2.Click OK to create the column.

3.Close the database form and click the Maintenance tab. In the 
Available Forms window, select the Matter form and click 
OK.

4.Expand the RESP_PERSON field and scroll until you locate the 
USER_ID column.
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5.Select the USER_ID column in the SQL Columns menu and 
drag it to the Matter form.

6.Double-click the field you dragged to the form; the Edit 
Attributes form appears. Change the USER_ID prompt to 
RESP_PERSON as you will be using USER_ID for both the 
RESP_PERSON and BILL_PERSON on this form.

7.Locate the Lookup Name field, click the lookup button, select 
People from the Lookup Name form, and then click OK.

8.Click the OK button on the Edit Attributes form.

9.Close the Matter form and save your changes.

10.Select File>Save and exit DM Designer.

11.Refresh the cache on DM Server to apply the changes.

Create the BILL_PERSON column:

1.In DM Designer, click the Database tab, highlight the 
MATTER table, and click New Column. Then enter the 
following information:

1.1 In the Column Name field, type BILL_PERSON.

1.2 In the Type field, select the integer option.

1.3 In the Key? field, select Foreign.

1.4 In the Link field, use the ellipses button to display a list 
of available tables to link to.

1.5 Highlight the PEOPLE table and click OK.

1.6 Verify that the link to the PEOPLE table is now in the 
text box.

2.Click OK to create the column.

3.Close the database form and click the Maintenance tab. In the 
Available Forms window, select the Matter form and click 
OK.

4.Expand the BILL_PERSON field and scroll until you locate the 
USER_ID column.

5.Select the USER_ID column in the SQL Columns menu and 
drag it to the Matter form.

6.Double-click the field you dragged to the form; the Edit 
Attributes form appears. Change the USER_ID prompt to 
BILL_PERSON as you will be using USER_ID for both the 
RESP_PERSON and BILL_PERSON on this form.
14  CHAPTER 2



7.Locate the Lookup Name field, click the lookup button, select 
People from the Lookup Name form, and then click OK.

8.Click the OK button on the Edit Attributes form.

9.Close the Matter form and save your changes.

10.Select File>Save and exit DM Designer.

11.Refresh the cache on DM Server to apply the changes.

Creating the
DELEGATES Table

1.In DM Designer, click the Database tab, and then click New 
Table.

2.In the Name and Description fields, type DELEGATES and click 
OK.

The DELEGATES table should now appear in the Table list. 

Create the PEOPLE_LINK column:

1.Highlight the DELEGATES table that you just created and 
click New Column.

2.In the Column Name field, type PEOPLE_LINK.

3.In the Type field, select the integer option.

4.In the Key? field, select Foreign.

5.In the Link field, use the ellipses button to display a list of 
available tables to link to.

6.Highlight the PEOPLE table and click OK.

7.Verify that the link to the PEOPLE table is now in the text 
box.

8.Click OK to create the column.

Create the DELEGATE_LINK column:

1.Highlight the DELEGATES table that you just created and 
click New Column.

2.In the Column Name field, type DELEGATE_LINK.

3.In the Type field, select the integer option.

4.In the Key? field, select Foreign.

5.In the Link field, use the ellipses button to display a list of 
available tables to link to.

6.Highlight the PEOPLE table and click OK.
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7.Verify that the link to the PEOPLE table is now in the text 
box.

8.Click OK to create the column.

Create the ACCESSRIGHTS column:

1.Highlight the DELEGATES table that you just created and 
click New Column.

2.In the Column Name field, type ACCESSRIGHTS.

3.In the Type field, select the integer option.

4.Leave all other fields at their default settings and click OK to 
create the column.

5.Click on Save Table. You will be asked if you want to create a 
new lookup called Delegates. Click Yes.

6.Click OK on the Table lookups for Delegates form. You will be 
asked if you want a link from the PROFILE table to the 
DELEGATES table. Click Yes.

7.Click Close and then exit DM Designer.
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C h a p t e r

3

Dynamic Views

Dynamic Views adds one or several dynamic folder views to DM 
Extension for Windows Explorer, the Quick Retrieve dialog box, and 
the DM Extension for Microsoft Outlook. This chapter contains the 
following topics:

• Default Dynamic Folder Views

• Document Searches

• Creating Documents

• Using the Drag-and-Drop Feature

• Ad Hoc Folders
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Default Dynamic Folder Views

Dynamic Views provides two default folder views: My Favorite Matters 
and My Recent Matters. You administrator may have provided additional 
views for your site. In addition, your administrator has the ability to 
change the titles for the views (see “View Settings” on page 50). 

• My Favorite Matters—Shows clients and matters explicitly 
subscribed to in Dynamic Profiling or Dynamic Views.

• My Recent Matters—Shows clients and matters for which 
you have edited a document in the last 30 days. 

Navigating the
Views

You can navigate and browse through Dynamic Views just as you would 
Windows Explorer or Outlook folders. For example, when a value is 
selected in the tree view, the items contained in it are displayed in the 
search results pane to the right. By clicking the plus-sign next to an 
item, you can expand it in the tree view.
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In the example above, the user has browsed to the matter “8888” for the 
client “ELBERT.” Folders representing document types appear beneath 
the expanded matter.

Document Searches

Depending on your setup, levels of the dynamic folder structure may 
contain search objects. Search objects provide a list of documents from 
criteria related to the value of the item under which the search object is 
selected. 

In the example below, the search object <My Documents> is selected for 
the matter “8888.” DM retrieves all documents and e-mail messages for 
the matter “8888.” By selecting different search objects on different 
levels, you can easily perform searches without using the search forms 
in DM.
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Dynamic Views, which are searches that show metadata in a logical tree 
structure, only display quick search results. If you do not have any 
searches defined, no documents are returned. The only exception to 
this is Adhoc Folders, which are real folders (as opposed to DVDP 
folders, which are virtual folders). Adhoc Folders existing in the tree 
structure will show the documents that fall underneath  without having 
to set up a search object. 
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Setting the Search
Object View

You can select what search objects you want to appear in the tree. 
Search objects are defined per level. 

1. Right-click the dynamic folder item under which you want 
the search objects to appear and select Settings>Edit available 
search objects.

2. From the drop-down box, select whether you want the 
search object to apply to the selected Client, Matter, or 
Document type.

3. Select the check box next to the search objects you want to 
appear at the selected level. If you want all of the listed 
search objects to appear, click Select All. To clear all of your 
current selections, click Clear.

The list of available search objects may be different from the 
example above, depending on how your administrator 
configures the available objects. 

Below is a description of the optional search objects:  

<My Recent Edits> All documents (including e-mail messages) 
that the user has edited or saved within the 
last 30 days. The administrator configures 
number of days. Default value is 30 days.
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4. Click OK to save your changes.

<My Recent Documents> All documents (excluding e-mail messages) 
that the user has edited or saved within the 
last 30 days. The administrator configures 
number of days. Default value is 30 days.

<My Recent Emails> All e-mail messages that the user has saved 
within the last 30 days. The administrator 
configures number of days. Default value is 
30 days.

<My Documents> Documents authored by the user. The search 
is linked to the author and not the typist.

<My Documents and Emails> Documents and e-mail messages authored 
by the user. The search is linked to the author 
and not the typist.

<My Emails> E-mail messages authored by the user. The 
search is linked to the author and not the 
typist.

<My Document Type> Documents of a certain document type. The 
administrator configures the document type. 
There may be several searches for different 
types.

<My Reminders> Document that have or will within 7 days 
pass a due date. The administrator 
configures the number of days and which 
field in the profile to use.

<All Documents and Emails> All documents and e-mail messages

<Filtered Documents> All documents except excluded applications 
and/or document types. You can configure 
the search object <Filtered Documents>. It 
performs a search where you can select 
applications and/or document types you 
want to exclude. To configure, select it and 
click the Edit button.
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Creating Documents

You can create a document directly from the virtual structure. 

1. Right-click a virtual folder and select New document. The 
standard Templates and Applications dialog box appears.

2. If you want to create a document using an existing 
template, click the Templates tab. If you want to create a new 
blank document using a specific application, click the 
Applications tab. 

3. Select OK. The document profile will appear with the fields 
filled out according to the item you initially selected in the 
folder view.

Using the Drag-and-Drop Feature

The drag-and-drop feature is supported in DM Extension for Windows 
Explorer and DM Extension for Microsoft Outlook. Dynamic Views 
supports two types of drag-and-drop operations:

• You can import a documents or e-mail messages to DM by 
dragging an item to the Client (or Tier one) node, the Matter (or 
Tier two) node, or the Document Type (enumeration) node of the 
tree structure.

• You can edit fields on the profile form by dragging DM documents 
to different locations in the virtual folder structure (listed above).

When you drag e-mail messages to the DM Extension for Microsoft 
Outlook node, e-mail messages are saved using the standard DM 
functionality. 

When you drag documents or e-mail messages to the virtual folder 
structure, the fields on the profile form are filled in according to the 
location to which the item is dragged in the virtual folder structure. By 
dragging an item to the lowest level, all metadata is entered in the 
profile form and further profiling is not necessary. Likewise, if 
documents are dropped on higher levels, and the appropriate drag-
and-drop settings are configured, further profiling is not necessary. For 
instructions on configuring the drag-and-drop settings, see “Drag-
and-Drop Settings” on page 24.
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Drag-and-Drop
Settings

Dynamic Views enables you to configure how metadata should be 
applied to lower levels when a document is dragged to a higher level. 
For example, when a document is dropped on a specific Client level, 
you can configure rules to determine which Matter should be selected 
and how the Document Type should be applied. 

To configure drag-and-drop settings: 

1. Right-click a virtual folder and select Settings>Drag and drop 
settings.

The content of the Drag and drop settings dialog box depends 
on how your virtual structure is set up. The example below 
is from a virtual folder structure that contains Matter, and 
Document Type.

2. Use the section If Matter cannot be determined to apply 
Matter automatically if it cannot be determined from the 
location to which the item was dragged. Your administrator 
has selected how the general Matter is recognized. By 
selecting the Use general Matter (suffix ‘Gen’) check box, 
Dynamic Views selects the general Matter when a 
document is dragged to the Client level. If no general 
Matter has been set up, the profile form appears from which 
you must select a matter. Your dialog box may list a 
different option after “suffix” as  the general Matter is 
configured by your administrator.
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3.  Select Set document type from application to apply the 
document type according to file type (application used). 
This setting applies if you drag a document to any level 
above the document type level. Click Map application to 
document type to define a document type for each 
application. 

4. Select the desired application from the Application drop-
down box. From the Document type drop-down box, select 
the document type you want used for documents using the 
selected application. Click Add to add the mapping to the 
list.

The list in the lower part of the dialog box shows the 
applications you have mapped to a document type.

When documents with mapped application types are 
dropped on a higher level of the virtual folder structure, the 
document type is filled in automatically based on these 
mappings. If the application type of a document is not 
mapped, the profile form is displayed for you to select an 
appropriate document type. If, for example, you map 
Microsoft Word and then import a WordPad document, 
but WordPad is not recognized by DM, the MS WORD 
document type is used.
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When using Outlook e-mail integration, the document type and application 
mapping that your administrator set up will be applied after the Dynamic Views 
drag-and-drop settings have been applied. 

Drag and Drop to
Ad hoc Folders

The concept of Ad hoc folders is explained in Ad Hoc Folders.

Since ad hoc folders are normal DM folders that are displayed in the 
virtual folder structure, dragging an item to such folders uses standard 
DM functionality. All metadata and security for the dragged document 
is inherited from the Ad Hoc folder. The rules configured using Drag and 
drop settings have no effect.

Ad Hoc Folders

The use of Ad Hoc folders gives you the option to create your own 
folders in the dynamic folder structure. This feature is enabled by the 
administrator and may not be available in your system. In addition, Ad 
Hoc folders may not be enabled on all levels.

Ad Hoc folders use the DM folder structure and become part of the 
dynamic folder structure. DM Folders have a profile with metadata as 
with any other document in DM. The metadata is used to determine 
where the folder should appear in the dynamic folder structure. An Ad 
Hoc folder created with Dynamic Profiling or Dynamic Views may be 
placed on any level of the dynamic folder structure.
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Creating an Ad Hoc
Folder

To create an Ad Hoc folder in Dynamic Views:

1. Right-click the item under which you want to add the folder 
and select New folder here.

2. You are prompted to enter a name for the folder. This text 
will be used as the document name as well as the display 
name for the folder. The rest of the fields on the folder’s 
profile form are filled in according to its location in the 
virtual folder structure.
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3. If you created the folder on any level but the lowest (such as, 
Document Type), the same rules used for drag-and-drop 
apply. See Drag-and-Drop Settings. If no drag-and-drop 
rules are activated, the document type Folder is used, if 
available. If Dynamic Views is unable to fill out all necessary 
fields on the Document Profile, the profile form for the 
folder is displayed for you to complete.

Security for the ad hoc folder will be applied according to your profile defaults. 
To change security for the folder, right-click the folder and select Profile from 
the DM Document menu.

4. A window is displayed informing you that the folder was 
created successfully. To refresh the tree view and view your 
new ad hoc folder, select Refresh from the View menu. 

5. An Ad Hoc folder icon  appears in the folder structure 
under the node you selected. It appears above the search 
objects and virtual folders.
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Adding Sub-
Folders to an Ad

Hoc Folder

Sub-folders can be added to Ad Hoc folders by right-clicking on the Ad 
Hoc folder and selecting Folder>New Sub-folder. This is different from the 
way sub-folders are created in Dynamic Profiling. The reason for this is 
that in Dynamic Views, the folder is represented by a standard DM 
Folder in the tree view. Metadata and security for the sub-folder will be 
inherited from the Ad Hoc folder. 
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C h a p t e r

4

DM Extensions Dynamic Profiling

DM Extensions Dynamic Profiling allows you to profile a document in 
a dynamic folder structure through the selection of a folder in a tree 
view. This chapter contains the following topics:

• Profiling Documents

• Subscriptions

• Ad Hoc Folders
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Profiling Documents

Dynamic Profiling adds a tab to the Document Profile dialog box. The 
tab contains a tree view of the dynamic folder structure based on fields 
from the standard profile. You can profile a document by making a 
selection in the tree view. 

To profile a document, enter a name in the Document Name field and 
browse down through the virtual folder structure. 

The fields on the document’s profile are filled in according to your 
selection in the tree. You can switch to the normal profile by clicking the 
Standard Profile tab.
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Subscriptions

The dynamic profiling tab shows the values you have selected, or to 
which you have subscribed. For example, in the situation in which a 
legal database is used and the virtual folder structure is built by Clients, 
Matters, and Document Types, Client and Matter levels are defined as 
Subscription Levels. You have the ability to select the values you want 
displayed when using Subscription Levels. Document Type is an 
Enumerated Level. Enumerated levels are automatically populated with 
all existing values. 

The virtual folder structure can contain anywhere from 1 to 3 
subscription levels, such as Office, Client, and Matter, or Country, 
Office, and Dept. Thus, a one level tree structure could contain Office 
or Country, or a 2 or 3 level tree structure could contain levels such as 
Client, and Matter, or Office, Client, and Matter. When dealing with 
enumerated levels, the virtual folder structure can contain none, 1 or 2.

+ Office

  + Client

    + Matter

Level 1
Level 2
Level 3
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Adding a
Subscription

To add a subscription to the virtual folder view:

1. You can subscribe to values using either the tree view, or 
from the Document Profile dialog box.

From the tree view, right-click the node to which you 
want to add subscriptions and select Subscriptions.

From the Document Profile dialog box, select the first 
tab and click Add New under the Subscribe section. (The 
administrator has the ability to rename this button. See 
“Modifying the Dialog Settings” on page 58.)

A dialog box appears from which you can select whether 
you want to add subscriptions from the Client or Matter 
table. 

2. When you select either Client or Matter, a table lookup 
appears from which you select the Client or Matter to 
which you want to subscribe. By selecting a Client, all 
currently linked Matters, as well as Matters linked to in the 
future, are added automatically.  When you select a Matter, 
the Client to which it belongs is added automatically.

3. The value to which you have subscribed is marked with an 
asterisk in the dynamic folder view. 

Removing a
Subscription

To remove an item from the virtual folder structure, right-click the 
subscription and select Unsubscribe. You can only remove a subscription 
from values to which you are subscribed. Specifically, you cannot 
unsubscribe from a Matter for a Client to which you have subscribed. 
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Likewise, you cannot unsubscribe from a Client for a Matter to which 
you have subscribed.

Adding an
Enumeration

Enumerations are defined by the administrator, and can be added by 
pressing the Document type button in the Restore exception section. 
When the Document type button is selected all values display for the 
user. 

Hiding an
Enumeration

If you want to hide an enumeration value from appearing in the 
enumerated list, you can enter that enumeration in the EXCEPTIONS 
table for each user by running a script. 

Removing an
Enumeration

You can remove an enumerated value (such as, a document type) by 
right-clicking it and selecting Unsubscribe. This will remove the value 
throughout the virtual folder structure. To recover the value, click the 
Add new button described above.

Viewing a Profile When using Dynamic Profiling, in order to view an item’s profile, select 
Profile from the Document menu in DM Extensions (or from the DM 
menu in Outlook). 

If you have the check box Start in tree tab selected in the lower left corner 
of the Dynamic Profiling tab, Dynamic Profiling will default to the 
Dynamic Profile tab. However, if any value on the profile is not on your 
subscription list, Dynamic Profiling will ask if you want to add the 
value. 

If you click No, the default DM profile appears. If you click Yes, the 
values are subscribed to without having to select them manually.
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Ad Hoc Folders

The use of Ad Hoc folders gives you the option to create your own 
folders in the dynamic folder structure. This feature is enabled by the 
administrator and may not be available in your system. In addition, Ad 
Hoc folders may not be enabled on all levels.

Ad Hoc folders use the DM folder structure and become part of the 
dynamic folder structure. DM Folders have a profile with metadata as 
with any other document in DM. The metadata is used to determine 
where the folder should appear in the dynamic folder structure. An Ad 
Hoc folder created with Dynamic Profiling or Dynamic Views may be 
placed on any level of the dynamic folder structure.

Creating an Ad Hoc
Folder

To create an Ad Hoc folder in Dynamic Profiling:

1. Right-click the item under which you want to add the folder 
and select New folder here.
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2. You are prompted to enter a name for the folder. This text 
will be used as the document name as well as the display 
name for the folder. The rest of the fields on the folder’s 
profile form are filled in according to its location in the 
virtual folder structure.

3. If you created the folder on any level but the lowest (such as, 
Document Type), the same rules used for drag-and-drop 
apply. See “Drag-and-Drop Settings” on page 24. If no 
drag-and-drop rules are activated, the document type Folder 
is used, if available. If Dynamic Views is unable to fill out all 
necessary fields on the Document Profile, the profile form 
for the folder is displayed for you to complete.

Security for the ad hoc folder will be applied according to your profile defaults. 
To change security for the folder, right-click the folder and select Profile from 
the DM Document menu.

4. A window is displayed informing you that the folder was 
created successfully. To refresh the tree view and view your 
new ad hoc folder, select Refresh from the View menu. 

5. An Ad Hoc folder icon  appears in the folder structure 
under the node you selected. It appears above the search 
objects and virtual folders.
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Adding sub-folders to an Ad Hoc folder

Sub-folders can be added to Ad Hoc folders by right-clicking on the Ad 
Hoc folder and selecting Create sub-folder. Metadata and security of the 
sub-folder will be inherited from the Ad Hoc folder.
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C h a p t e r

5

Using the DM Dynamic Views and

Profiling Configuration Utility

Using the DM Dynamic Views and Profiling Configuration Utility 
allows you to define the tree structure that users see. It also enables you 
to define the labels and messages displayed to users. In order for you to 
define the tree structure, you must have an understand how to use DM 
Designer to customize your DM library and DM Profiles. This chapter 
contains the following topics:

• Starting the Configuration Utility

• Specifying a Profile Form

• Overview of the Configuration Utility Interface

• Defining the Tree Structure

• Defining the Views

• Setting Up Search Objects

• Modifying the Dialog Settings

• Defining Settings on the Dynamic Profile

• Replacing the Standard Icons
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Starting the Configuration Utility

The DM Extensions Dynamic Views & Profiling Configuration Utility 
uses the DM API to communicate with the database, thus there is no 

need for direct database access in order to run the utility. 

To start the configuration utility:

1. Log on to DM using a DOCS_SUPERVISORS account. If 

DM is started, the configuration utility will use that session; 

if DM is not running, you must log on when you start the 

utility.

2. Select Start>Program Files>Hummingbird>DM Extensions 
Dynamic Views & Profiling Configuration Utility. 

Specifying a Profile Form

Tree definitions created using the configuration utility are associated 

with a specific profile form. Before modifying the tree structure or 

search objects, you must specify the form to which the tree structure 

and search objects are associated. 

The configuration utility provides the <Primary> form listed for the 

DOCS_SUPERVISORS group as the form that must be selected before 

modifying the tree structure or search objects. In addition, the selected 

profile form must be designated as the primary profile form for any 

groups that will be using Dynamic Views.

Thus, the following steps must be taken to ensure all Dynamic Views 

users are using the correct profile form: 

1. Using Library Maintenance, ensure that each user group 

that will be using Dynamic Views is using the same 

<Primary> Profile Entry form. (Select Groups and double-

click the desired group. Select Forms from the Tools section. 

Double-click Profile Entry, then select <Primary>.)
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2. In order for the configuration utility to provide the correct 
profile form for selection, before launching the 
configuration utility, the <Primary> Profile Entry form for 
the DOCS_SUPERVISORS group must be set to the same form 
selected in step 1 above. If the DOCS_SUPERVISORS 
group does not usually use this form, the form can be 
changed back to the previously selected form after the 
configuration utility settings have been modified. 

Overview of the Configuration Utility Interface

The configuration utility provides the following main tabs:

• View Definitions—Enables you to set the views you want 
available to users in DM Dynamic Views (on the Quick 
Retrieve dialog box, in DM Extension for Windows 
Explorer, or DM Extension for Microsoft Outlook) and how 
these should appear. You can also set global settings such as:

If folders should be available in DM Dynamic Views.

If drag-and-drop operations onto virtual levels should 
be allowed.

What folder methods to use.

See “Defining the Views” on page 48 for more information.

• Tree Structure—Defines the structure of the dynamic views 
for DM Dynamic Views and DM Dynamic Profiling. 
Contains tabs for IDs, descriptions and presentation. See 
“Defining the Tree Structure” on page 42 for more 
information. This tab also contains the Inherited Security 
settings. See “Inherited Security” on page 65 for more 
information.

• Search Objects—Defines which search objects should be 
available to users and enables parameters to be customized 
for these objects. See “Setting Up Search Objects” on page 
51 for more information.

• Dialog Settings—Sets labels and captions in the different 
dialog boxes of DM Dynamic Views. See “Modifying the 
Dialog Settings” on page 58 for more information.
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• DP Settings—Sets the labels and captions on the Dynamic 
Profile tab in the profile form. You can also enable the use of 
folders and make Security and Change Trustees options 
available to users. See “Defining Settings on the Dynamic 
Profile” on page 59 for more information.

Defining the Tree Structure

This section assumes you are familiar with profile customization in DM 
Designer. Please read “Specifying a Profile Form” on page 40 before you 
start configuring DM Dynamic Views and DM Dynamic Profiling.

The tree structure you define in the configuration utility must cover all 
mandatory fields on the Document Profile, except Document Name 
and Author. When you define the structure, it should be set up in a way 
that appears logical to users.

Each level of the structure corresponds to a lookup field on the 
Document Profile. There are two main types of levels in DM Dynamic 
Views and DM Dynamic Profiling:

• Subscription Levels

• Enumeration Levels

Subscription Levels A subscription level is a field on the Document Profile to which users 
can “subscribe.” When users subscribe to a value, the value will appear 
in his or her tree view. Subscription levels are typically used for fields 
that are related in a hierarchical way, such as Customer and Project or 
Client and Matter. For example, a user of the profile form LAWPROF 
wants to select certain Clients and the associated Matters to appear in 
his or her tree. The DM administrator must first define Client and 
Matter as subscription levels. Then the user can select individual values 
from the Client table to appear in the tree. All Matters related to the 
selected Clients will automatically appear in a subordinate relationship 
(or lower level in the hierarchy) to the Client name. 

At least one subscription level must be defined, and up to three can be 
defined. If a field defined as a subscription level—such as Client— is 
linked to another field on the Document Profile—such as Matter—
define both fields as subscription levels. Multiple subscription levels 
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cannot be defined using fields that are not linked to each other. Only 
fields using a table lookup can be selected as subscription levels.

Enumeration
Levels

Enumeration levels are fields where the user receives all values 
automatically in the tree. Up to two enumeration levels can be defined. 
Typically, fields like Document Type are set up as enumeration levels. 
Enumeration levels can be linked to each other, although this is not 
required. Only fields using a table lookup can be selected as 
enumeration levels.

Users can exclude values in enumeration levels using:

• The Unsubscribe button on the first level of enumeration in 
the Dynamic Views context (right-click) menu. 

• The Subscribe dialog box (right-click My Favorites or the 
profile form).

When a user chooses to exclude a value, it is removed throughout the 
tree. 

It is not required for you to set up enumeration levels. However, 
because Document Type is a field that likely appears in any Document 
Profile and would normally be defined as an enumeration level, you 
must set the Document Type field to a default value if you do not set it up 
as an enumeration level.

Differences
Between

Subscription and
Enumeration

Levels

The following table shows the differences between subscription and 
enumeration levels.

Subscription Level Enumeration Level

Must be represented by a lookup field. Must be represented by a lookup 
field.

Users can subscribe to values. Users get values automatically 
(except the ones they exclude).

Several levels must be linked. Several levels can be linked.
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Tree Structure Tab The Tree Structure tab is used to define what the tree—used in both DM 
Dynamic Views and DM Dynamic Profiling—looks like. It consists of 
three tabs:

• Levels ID (See “Defining Levels” on page 45.)

• Levels Description (See “Defining Level Descriptions” on 
page 46.)

• Levels Layout (See “Defining the Layout of Levels” on page 
47.)

Before you can use any of the tabs to define the tree, you must select a 
profile form to which the tree definition is associated. Ensure the 
profile form you select is the primary profile form for the 
DOCS_SUPERVISORS group and for all user groups that will be using 
Dynamic Views. See “Specifying a Profile Form” on page 40 for details.

The three tabs on the Tree Structure tab are linked. You must define the 
levels, their descriptions, and the way they are presented (the level 
layout) before you can save the entire definition for the profile.

Tree Definitions when Additional Profiles are Defined

If your site has set up additional profile forms for one or more 
application types (such as different profile forms for e-mail messages, 
folders, and paper documents), when you finish the tree definition and 
click Save, a dialog box appears asking you to select additional profiles. 
If you want the tree definition to apply to these profiles, select them in 
the list and click OK. 

At least one subscription level must be 
defined.

Enumeration levels do not have 
to be defined.

Up to three subscription levels can be 
defined.

Up to two enumeration levels can 
be defined.

Typically used for fields such as Client/
Matter or Customer/Project where users 
would want to select what to see.

Typically used for Document Type, 
Parent Document Type/Document 
Type, or other fields that should 
appear automatically throughout 
the tree.
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Defining Levels

1. Select the Levels ID tab. 

2. In the Subscription Levels - ID section, type or select the 
number of levels you want to use as subscription levels in 
the Linked Levels (1 to 3) box. 

3. Select the fields you want to use as subscription levels in the 
Level 1, Level 2, or Level 3 boxes. These boxes list all fields on 
the Document Profile that are linked to another table. They 
are listed using the syntax:

[Prompt]([FIELD NAME]) ([TABLE NAME])

 Select only fields that use a table lookup on the Document 
Profile.

4. In the Enumeration Levels - ID section, type or select the 
number of levels you want to use as enumeration levels in 
the Linked Levels (0 to 2) box.

5. Select the fields you want to use as enumeration levels from 
the Level 1 or Level 2 boxes. These boxes list all fields on the 
Document Profile that are linked to another table. They are 
shown in the syntax:

[Prompt]([FIELD NAME]) ([TABLE NAME])

 Select only fields that use a table lookup on the Document 
Profile.
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6. Continue with the next step, “Defining Level Descriptions” 
on page 46.

Defining Level Descriptions

For each level you defined on the Levels ID tab, you must select a 
description using the Levels Description tab. 

To set the level descriptions:

1. Select the Levels Description tab. 

2. In the Subscription Levels - Description section, select the Full 
Name or Description entry for each Level ID you created. 
This description is used as an alternative display name for 
the nodes of the tree. If a level does not have a 
cooresponding description field, you should select the same 
field as the one you selected under the Levels ID tab. Make 
sure you select description fields that are from the same 
table as the ID fields for the respective levels. 

3. Perform the same action from step 2 for the Enumeration 
Levels - Description section.

4. Continue with the next step, “Defining the Layout of 
Levels” on page 47. 
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Defining the Layout of Levels

1. Select the Levels Layout tab.

2. In the Subscription Levels - Layout section, select a layout (or 
the way in which the level is displayed in the tree) for each 
level you have created. 

• ID—Values are displayed with the ID field (from the 
Levels ID tab).

• Description—Values are displayed with the Description 
field (from the Levels Description tab).

• ID and Description—Values are displayed in the form 
ID — Description.

• Description (ID)—Values are displayed in the form 
Description (ID).

3. For each level you can enable or disable the display and 
creation of Ad Hoc folders by selecting or clearing the AdHoc 
Folders check box for each level. For example, if you want to 
allow users to create Ad Hoc folders only on the lowest level 
in the tree, you would clear all AdHoc Folders check boxes 
except the last enumeration level. If you want to turn off Ad 
Hoc folders completely, use the View Definitions tab. See 
“Defining the Views” on page 48 for details.If you have 
more than one subscription level, you have the option of 
defining a Drop Default Suffix for Level 2 and any subsequent 
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level. If a Drop Default Suffix is defined, a user can drag a 
document to the top subscription level and the Level 2 
value will be filled in with the Drop Default Suffix. The 
Drop Default Suffix must be an existing value in the Level 2 
table. 

Users determine if they want to use the default Level 2 value 
using the drag-and-drop settings (see “Drag-and-Drop 
Settings” on page 24). 

For example, if an organization uses a Client/Matter 
definition and sets the Drop Default Suffix to DEF for the 
second (Matter) level. A DM Dynamic Views user can then 
define DEF as his General Matter. When the users drops a 
document on the Client level, it is automatically applied to 
the user’s General Matter, in this case, the DEF Matter. If 
the Drop Default Suffix is not defined or the user has not 
defined the suffix as his General Matter, when he drops a 
document on a client node, the Document Profile appears 
in order for him to select a Matter. 

Defining Level
Icons

You can change the icons displayed for each level. The current icons are 
shown to the right of the Tree Strcture tab. Your organization’s custom 
icons can be used in place of the default icons provided by DM. See 
“Replacing the Standard Icons” on page 62 for more information.

To change an icon:

1. Right-click the icon you want to change.  

2. Click an icon from the Select Icon window. 

3. Click OK. The new icon will be displayed in the tree view 
when users next log on DM Extensions.

Defining the Views

The previous section, Defining the Tree Structure, described how to set 
up the structure that will be used by DM Dynamic Views and DM 
Dynamic Profiling. Dynamic Views supports multiple views in the DM 
Extension tree. On the View Definitions tab, you define what views are 
available to users. 
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Setting View
Options

1. Click the View Definitions tab.

2. In the View Options section, select the options for your site:

Enable Multiple Views—Selecting this option enables the 
display of multiple views—such as Subscription, Recent, 
and All—in the tree. When Enable Multiple Views is turned 
off, only one view at a time is displayed; to display a 
different view, users must right-click on the view and select 
the new view. 

Enable Foldering—Users can use the Ad Hoc folder feature 
in DM Dynamic Profiling and DM Dynamic Views. See 
“Setting up Ad Hoc folders” on page 49.

Enable Drop on Levels—When the user drops a document 
on a high level, it applies all profile information for that 
level and subsequent levels down to the lowest level. For 
example, if an organization uses a Client/Matter definition 
and a user drops a document on a Client, the profile 
assigned to the document will contain all metadata for the 
client and its matters.

Hide “New Document”—Removes the option to create a 
new document in the tree structure.

Hide “New Mail”—Removes the option to add a mail 
message to the tree structure.

Hide “Edit Search Objects”—Removes the option Edit 
available search objects from the right-click menu.

Use Alternative Foldering—This option is no longer used 
in the product.

Setting up Ad Hoc folders

Ad Hoc folders enable you to create and add your own DM folders to 
the tree structure. Ad Hoc folders work the same in Dynamic Profiling 
and Dynamic Views.

The location of a DM folder in the virtual tree structure is determined 
by the folder’s profile metadata. For example, a DM folder that has a 
Client of 1 and a Matter of 1 would be located under Client 1>Matter 
1>Document Type Folder in the tree structure. In contrast, an Ad Hoc 
folder created with Dynamic Profiling or Dynamic Views can be placed 
on any level of the dynamic folder structure. In the example above, an 
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Ad Hoc folder could exist under the Client 1 node. Existing folders 
automatically appear on the lowest level of the tree structure.

You can enable and configure Ad Hoc folders using the configuration 
utility. 

• To allow Ad Hoc folders at the highest level, select the check 
box Enable Foldering on the View Definitions tab. This enables 
users to create and view Ad Hoc folders in the Dynamic 
Views in DM Extension for Windows Explorer and DM 
Extension for Microsoft Outlook, and in the Quick Retrieve 
dialog box. The Enable Foldering check box must be selected 
to enable the following two abilities.

To allow users to view and create Ad Hoc folders on the 
Dynamic Profile tab on the Profile form, select the check 
box Enable Foldering on the DP Settings tab.

To select the subscription levels on which users can 
view and create Ad Hoc folders, select the AdHoc Folders 
check box for each level on the Tree Structure tab’s Levels 
Layout tab. For example, with a Client/Matter/
Document Type tree structure, you might want users 
to view and create Ad Hoc folders on the Document 
Type level. To set this up, you would clear AdHoc Folders 
for the first (Client) and second (Matter) levels. Ad 
Hoc folders would then serve as a way for users to 
further structure documents beneath each document 
type folder, such as a “Final Agreement” sub folder in a 
Agreement Document Type folder. By also enabling Ad 
Hoc folders on the Matter level, users could then create 
folders like “Matter Summary” in which they could 
group documents together with different Document 
Types. When allowing Ad Hoc folders on higher levels, 
carefully consider how you want users in your 
organization to utilize them. 

View Settings When using Dynamic Views, you can set what views (or nodes) are 
displayed in the tree view. You can also set the Display Name for the 
node. 
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To edit, or hide a view:

1.  Select the View Definitions tab.

2. From the View Settings section, select the view you want to 
edit from the View drop-down box:

• My Subscriptions—Shows the values the user has 
selected. This view is identical to the one available in DM 
Dynamic Profiling.

• My Recent—Automatically selects the values in the 
subscription levels according to the documents the user 
has edited during the last 30 days. (30 days is the default, 
which can be changed).

• All Values—Shows all values available.

• All Values (per letter)—Shows all values, but adds a first 
level with first letters of the available first values (A, B, 
C…).

• My Recent (from activitylog)—Shows items for which 
you are the author, or items that you have edited or 
imported.

3. To change the text used for the node in the tree view, edit 
the Display Name field. To hide a view, clear the text from the 
Display Name field. 

4. To change the icon for the node, right-click the icon and 
select a new icon from the Select Icon window. Click OK to 
save your selection. See “Replacing the Standard Icons” on 
page 62 for information on using your own icons.

5. Click Save for your changes to take affect.

Setting Up Search Objects

Search objects provide a list of documents from criteria related to the 
value of the item in the tree under which the search object is selected. 
The criteria for each search object are set to the values from the 
respective location in the tree as well as extra criteria, such as 
Author=logged in user (for the search object <My Recent 
Documents>).

The configuration utility allows you to select search objects from a list 
of default search objects, or you create your own custom search objects. 
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After you set up default or custom search objects using the 
configuration utility, users can then add search objects to their 
Dynamic Views (see “Document Searches” on page 19). 

To set up the default search objects:

1. In the configuration tool, click the Search Objects tab.

2. From the Profile drop-down box, select the profile form to 
which the search objects will be associated. For information 
on selecting this form, see “Specifying a Profile Form” on 
page 40.

3. The Search drop-down menu lists the default search objects, 
described below. Select the search objects you want to be 
available for user selection or by default.   

<My Recent Edits> All documents (including e-mail 
messages) that the user has edited or 
saved within the last 30 days.
Set with the parameter Recent Days. 
Default value is 30 days.
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4. You can modify the name used in the tree view for a default 
search by entering custom text in the Display Name field.

5. The Use Activitylog check box affects the way in which the 
<My Recent Edits>, <My Recent Documents>, and the 
<My Recent Emails> search is initiated. If the Use Activitylog 
check box is cleared, the following search criteria is used:

<My Recent Documents> All documents (excluding e-mail 
messages) that the user has edited or 
saved within the last 30 days. Set with 
the parameter Recent Days. Default 
value is 30 days.

<My Recent Emails> All e-mail messages that the user has 
saved within the last 30 days. Set with 
the parameter Recent Days. Default 
value is 30 days.

<My Documents> Documents that the user is the 
author of.

<My Documents and Emails> Documents and e-mail messages that 
the user is the author of.

<My Emails> E-mail messages that the user is the 
author of.

<My Document Type> Documents of a certain document 
type. Set with the parameter 
Document Type.

<My Reminders> Document that have or will within 7 
days pass a due date. The number of 
days is set with the parameter 
Reminder Days. The field that 
Dynamic Views looks at can be set in 
the Reminder field. The names of the 
Search Objects can be changed by 
editing Display Name.

<All Documents and Emails> All documents and e-mail messages

<Filtered Documents> All documents except excluded 
applications and/or document types. 
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TYPIST=USER + Edited%Today Minus x days TO % TODAY

If the Use Activitylog check box is selected, the following 
search criteria is used:

Search ACTIVITYLOG

When the Use Activitylog check box is selected, it is possible 
to run into performance issues if you site usually maintains 
a large ACTIVITYLOG table.

Further, if you select the Use Activitylog option, documents 
of which you are the author, or documents that you have 
edited or imported will be displayed. However, if you opt 
not use the Use Activitylog option, only documents of which 
you are the Typist will be displayed. 

6. In the Active on Levels field, enter the tree levels on which 
you want to enable the search object to be selected. Number 
1 corresponds to the highest level in the tree structure, 
number 2 corresponds to the next lowest level, and so on. 
For example: 

If you leave the Active on Levels field empty, the search 
object will not be available for users to select on any level. 
This is the same as selecting the Disabled check box, 
described below, for the search object.

7. You can disable a search object by checking the Disabled 
check box. If you disable a search object, it will not be 
available for users to select on any level. 

8. As opposed to having users select the desired search objects, 
you can select the Default check box to set the search object 
to be displayed by default for users.

Users can remove a search object set as default by the 
administrator using the info in “Setting the Search Object 
View” on page 21? 

9. Click Save to save the changes to made to the selected search 
object. Repeat steps step 4 through step 8 for each search 
object you want to provide to users.

+ Office

  + Client

    + Matter

Level 1
Level 2
Level 3
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To set up custom search objects:

1. In the configuration tool, click the Search Objects tab.

2. From the Profile drop-down box, select the profile form to 
which the search objects will be associated. For information 
on selecting this form, see “Specifying a Profile Form” on 
page 40.

3. To add a custom search objects, click Add New and enter 
values for Display Name, Criteria, and Active on Levels. 

4. Click Save to save the new custom search object.

Repeat these steps to create additional custom search objects. Consult 
the following section for information about the search conditions you 
can use.

Custom Search
Logical Conditions

You can use the following search conditions in the Criteria field to 
define your search objects:

Profile Fields with... Available Conditions

Numeric or Date Values  Equal to
Greater than
Less than
Not equal to
Less than or equal to
Greater than or equal to

Document Contents Contains Phrase
Contains Any Word
Contains All Words
Does Not Contain
Nearby Words
Starts With
Ends With

Other Values Equal to
Not equal to
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The available conditions are described below:

Condition Description

Equal to The value in the document must equal the 
search criteria. For example, searching for 
AUTHOR = “J_SMITH” will only return 
documents where J_SMITH is the author.

Not equal to The value in the document must not equal the 
search criteria. For example, searching for 
AUTHOR != “J_SMITH” will only return 
documents where J_SMITH is not the author.

Greater than The value in the document must be greater than 
the search criteria. For example, searching for 
CREATION_DATE > 04/03/2006 will only 
return documents created on dates later than 
04/03/2006.

Less than The value in the document must be less than the 
search criteria. For example, searching for 
CREATION_DATE < 04/03/2006 will only 
return documents created on dates previous to 
04/03/2006.

Less than or equal to The value in the document must be less than or 
the same as the search criteria. For example 
searching for CREATION_DATE <= 04/03/
2006 will return documents created on 04/03/
2006 or earlier.

Greater than or equal to The value in the document must be more than 
or the same as the search criteria. For example, 
searching for CREATION_DATE >= 04/03/
2006 will return documents created on 04/03/
2006 or later.

Contains Phrase The exact phase must be found in the 
document. For example, searching for “sample 
document” will return a document with the 
sentence “This is a sample document,” but not a 
document with the phrase “This document is a 
sample.”
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Contains Any Word Any single word specified in the search criteria 
must be found in the document. Separate 
individual words with semicolons (;). For 
example, searching for “sample;document” 
will return documents containing either 
“sample” or “document.”

Contains All Words All of the words specified in the search criteria 
must be found in the document. Separate 
individual words with semicolons (;). For 
example, searching for “sample;document” 
will only return documents containing both 
“sample” and “document.”

Does Not Contain The words or phrase specified in the search 
criteria must not be found in the 
document.Separate individual words with 
semicolons (;). For example, searching for 
“sample;document” will only return 
documents that do not contain the words 
“sample” or “document.”

Nearby Words The words specified in the search criteria must 
be found close to one another. You specify how 
far apart the words may be in the Words Apart 
field on the Custom Search tab. For example, 
searching for Nearby Words 
“sample;document” and setting the Words 
Apart field to 2 will return a document with this 
sentence: “This is sample document” but not 
this sentence: “This sample shows a typical 
document.”

Starts With A word in the document must begin with the 
search criteria. Separate entries with semicolons 
(;). For example, searching for 
“glob;enviro” will return documents 
containing “globe,” “global,” “environs,” and 
“environment.”

Condition Description
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Modifying the Dialog Settings

The Dialog Settings tab contains a tab for each dialog box users see when 
accessing Dynamic Views. On the tabs for a dialog box, you can modify 
the field captions and button labels, the text of messages, and other 
user-interface options associated with that dialog box. Each tab has a 
Preview button where you can see the effect of any changes you make to 
the default settings. The Restore Defaults button replaces any changes 
with the original default values. After making changes, you must click 
Save in order for your changes to be available to users.

The following dialog boxes can be modified:

• Create Folder

• Filter Settings

• Enable Search Objects

Ends With A word in the document must end with the 
search criteria. Separate entries with semicolons 
(;). For example, searching for “ious;ology” 
will return document containing “envious,” 
“obvious,” “biology,” and “ecology.”

Condition Description
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• List of Mappings

• Subscriptions

• Select View

• Exceptions

• Subscription Users

• Drag and Drop Settings

• Create Folder from Template

Defining Settings on the Dynamic Profile

Use the DP Settings tab to define the labels and captions used on the 
Dynamic Profile. You can also enable the ability to create Ad Hoc 
folders and make available the security options on the Document 
Profile.

To modify the Dynamic Profile settings:

1. Click the DP Settings tab.

2.  Modify the fields as described below. When modifying the 
labels for tabs or options, a preview of the labels is provided 
to the right of the dialog box. 
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Enable Foldering—Select this check box to allow users to use 
the Ad Hoc folder feature in Dynamic Profiling. Note that 
an additional field is needed in the Profile table to define 
the level at which the Ad Hoc folder was created and the 
levels at which the Ad Hoc folder is available in the tree-
structure tab.

DP Tab Caption—Use this field to modify the label appearing 
on the Dynamic Profile tab. The default label is DM - 
Dynamic Profiling. 

Profile Tab Caption—Use this field to modify the label 
appearing on the standard Profile tab. The default label is 
Profile.

Subscribe Frame—Use this field to modify the label 
appearing at the top of the Subscriptions frame, a graphical 
box on the Dynamic Profile that encloses the button 
allowing users to add a subscription to their tree. By default, 
the label is Subscriptions. 

Subscribe Button—Use this field to modify the label 
appearing on the Add New button in the Subscriptions box on 
the Subscribe dialog box that appears when users right-click 
the My Favorite Matters item in the tree. The default label is 
Add New.

Security Visible—Select this check box to allow users to see 
the Secure check box on the Dynamic Profile. If the Security 
Visible check box is not selected, the Secure check box on the 
profile is invisible and users are unable to apply DM 
security to the document.

Security Frame—Use this field to specify the label appearing 
at the top of the Security frame on the Dynamic Profile. This 
frame encloses the Secure check box, which allows users to 
apply security to a document, and the Edit button, which 
brings up the Access Control List. By default the label is 
Security. 

Security Caption—Use this field to modify the label 
appearing on the Secure check box within the Security frame 
on the Dynamic Profile. The default label is Secure. 
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Trustees Visible—Select this check box to allow users to see 
the Edit button within the Security frame on the Dynamic 
Profile. If the Trustees Visible check box is not selected, users 
are unable to access the dialog box showing the Access 
Control List of users who may access the document and 
their access rights.

Trustees Caption—Use this field to modify the label 
appearing on the Edit button within the Security frame on 
the Dynamic Profile. This button brings up the Access 
Control List where users define who has access to the 
document. The default label is Edit. 

Start in Tree Tab—Use this field to modify the label appearing 
on the Start in Tree tab check box on the Dynamic Profile. 
This check box governs whether the Dynamic Profile is 
displayed first. The default label is Start in Tree Tab. 

Hide Client—Use this field to modify the label appearing on 
the Hide Client tab check box on the Dynamic Profile. This 
option lets the user hide the top subscription level and 
display only the lower levels in the tree hierarchy. For 
example, if the subscription levels are Client and Matter 
and the user selects Hide Client, only the Matters will appear 
in the tree. The default label is Hide Client, but this should 
be changed if your organization’s Dynamic Profile is not 
LAWPROF or your first subscription level is not Client. 

Folder Form Name—By default, this is set to <same as 
document form name>. 

Create Folder from Template Source—Enter the document 
number of the template folder structure that is to be used 
for the Create Folder from Template option that appears when 
users right-click in the Dynamic Profiling tree. The use of 
Ad Hoc folders must be enabled for the Create Folder from 
Template Source option to work.

Restore Default—Click this button to restore all fields 
defining captions/labels to their default values.

3. To save your changes, click Save. Your changes will be 
reflected in Dynamic Views when users log on next time. 
Users who are logged on during the save will not see 
changes until they end the current session and log on again.
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Replacing the Standard Icons

If your organization prefers to use custom icons in the tree, you can 
replace the standard icons with your custom ones:

1. Navigate to the folder \Program Files\Hummingbird\DM 
Dynamic Views and locate the folder \DM - Icons.

2. Replace the existing icon files with your custom files, using 
the same names and the same number of files.

3. Start the configuration utility and click Update Icon Resource 
File to create a new version of DVIcons.dll in the \DM - 
Icons folder. 

4. Copy DVIcons.dll from the \DM - Icons folder to your 
Windows System32 folder, replacing the existing copy in 
that folder. 

5. Verify that multiple copies of DVIcons.dll do not exist on 
your machine.

The new icons will appear when users log on to DM Extensions.
62  CHAPTER 5



C h a p t e r

6

Matter-Centric Security

This chapter, which contains information about setting up and using 
matter-centric security, includes the following topics:

• About Matter-Centric Security

• Implementation Considerations

• Inherited Security

• Defining a Matter’s Security

• Profiling Documents

• Subscribing

• Reassigning Documents to Different Matters

About Matter-Centric Security

Using Dynamic Views allows you to create a matter-centric security 
model, where security for documents is based on the security defined 
for a Matter. Delegates, such as paralegals or secretaries, can define 
which users and groups are granted access to a particular Matter, 
instead of having to apply security to each document. Delegates are 
assigned by the RESP_PERSON (Responsible Person 1 or 2) users of 
Matters. Each Matter will have a RESP_PERSON and BILL_PERSON 
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(Billing Person) assigned by the Matter form when you follow the 
instructions in Implementing Matter-Centric Security section in the 
“Installing Dynamic Views” chapter. These two fields (RESP_PERSON 
and BILL_PERSON) are not required, but adding these fields to the 
Matter form allows you to designate users other than from the 
SUBSCRIPTION_MANAGER group to define Matter-level security. 

A user can only define security or assign delegates to define security in 
the Matters in which he/she is designated a Responsible Person. Also, 
when a Responsible Person assigns a delegate, that delegate has rights 
to assign security for all Matters in which that person is responsible for.

When you define security for a Matter, all documents and/or folders 
stored or saved within that Matter inherit that Matter’s security. Users 
can, however, apply custom security if needed. You can set custom 
security during the document creation process, or after the document 
is saved, you can set custom security if you have rights to that Matter. 
Applying custom security is the same as applying security in DM; you 
select and assign rights to users and/or groups through the Access 
Control List (ACL). 

To implement matter-centric security, you must first configure 
Dynamic Views. Consult the Implementing Matter-Centric Security 
section in the “Installing Dynamic Views” chapter for the configuration 
settings.

Implementation Considerations

Before you implement matter-centric security, you should ensure that 
you want all documents to be secured within all Matter levels—because 
once you apply the security, it cannot be removed by disabling the 
matter-centric security. To remove the Matter’s security, you would 
need to manually alter the security for each document within each 
Matter.

Even if you disable matter-centric security, the security that was 
originally applied is maintained on each of the Matter’s documents. 

Until you define a Matter’s security, the documents within the Matter 
keep their existing security. After you define security for each Matter, all 
existing documents will inherit the security you defined for their 
corresponding Matters. 
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Maintaining
Custom Security

for Documents
Transferred to a
Different Matter

When you move documents that have custom security set from one 
Matter to another Matter, the document inherits the new Matter’s 
security. If you want to maintain custom security set on a document 
that you are transferring to another Matter, you should select the Keep 

Custom Security check box on the DVDP Configuration Utility’s 
Inherited Security tab.  

The Inherited Security tab and its settings are described in the 
following section.

Inherited Security

When you enable matter-centric security, the DOCS_SUPERVISORS 
group, the account logged on to DM, and the group given access rights 
(such as the SUBSCRIPTION_MANAGER group), are the only users 
and groups with rights to all Matters. 

The account logged on to DM must be a member of either the 
DOCS_SUPERVISORS or SUBSCRIPTION_MANAGER group.

The SUBSCRIPTION_MANAGER group, the DOCS_SUPERVISORS 
group, or the Security Responsible Person 1 and 2 users can delegate 
security control to other users; these users can set security in Matters 
they have been given access, 

These groups and users also designate which users can control each 
Matter’s security through the DVDP Configuration Tool’s Tree 
Structure>Inherited Security tab.

For more information about delegating, please refer to the Defining a 
Matter’s Security section.
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The Inherited
Security Tab

Only DOCS_SUPERVISORS group members can access the DVDP 
Configuration Tool.

There are two check boxes on the Inherited Security tab: 

Enable Inherited Security—Select this check box for all new documents 
and/or folders to inherit the Matter’s security. The existing security is 
replaced with the Matter’s defined security.

Keep Custom Security—When you select this check box, custom security is 
maintained when you transfer documents that already have custom 
security set from one Matter to a different Matter. 

Within the Security Settings section, the following parameters are set:

Inherit security from: Click the drop-down menu to select the Dynamic 
View. In the example above, the MATTER Dynamic View is selected.

Description: This is the descriptive name of the Matter.

Security Manager’s Group: Click the drop-down menu to select the group. 
In the example above, the SUBSCRIPTION_MANAGER group is 
selected.

Security Responsible person Link 1: Click the drop-down menu to select the 
User ID of the user responsible for delegating defining matter security 
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to other DM users. In the example above, the RESP_PERSON is 
selected.

Security Responsible person Link 2: Click the drop-down menu to select the 
User ID of the user responsible for billing. In the example above, the 
BILL_PERSON is selected.

Allow Trustees Removal Section

The Allow trustees removal section of the Inherited Security tab allows 
you to designate a group or user to remove user rights from a Matter.

Within the Allow trustees removal section, the following parameters are 
set:

Security Manager group can be removed by: Click the drop-down menu to 
select from the following options:

• Security Manager Group

• Anyone with access

• <Cannot be removed>

In the example above, the Security Manager Group is selected.

Responsible person 1 can be removed by: Click the drop-down menu to 
select from the following options:

• Security Manager Group

• Anyone with access

• <Cannot be removed>

In the example above, the Security Manager Group is selected.

Responsible person 2 can be removed by: Click the drop-down menu to 
select from the following options:

• Security Manager Group

• Anyone with access

• <Cannot be removed>

In the example above, the Security Manager Group is selected.
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Defining a Matter’s Security

For Matters under their control, the RESP_PERSON (Responsible 
Person) user can delegate defining matter-security to other DM users. 
For example, lawyers might delegate this duty to their secretaries or 
paralegals. Each lawyer can have multiple secretaries and each secretary 
can work for multiple lawyers. Delegating can be done in any of the 
DVDP top nodes, by right-clicking nodes such as My Favorite Matters 
or All Matters, and then selecting Delegate. A lookup window appears, 
which lists all users from the PEOPLE Table, in which you can select 
one or multiple users to delegate.

Any member of the DOCS_SUPERVISORS group (or other group with 
appropriate access rights) can delegate defining matter-security for all 
available Matters by adding users to the SUBSCRIPTION_MANAGER 
group.

The SUBSCRIPTION_MANAGER group, the RESP_PERSON user 
(lawyer, for example), the BILL_PERSON (billing employee), and 
delegated users have normal access rights to documents saved to a 
Matter that has no security defined. 

The document's Author and Typist always have full control of a 
document, regardless of the matter-centric security applied, with one 
exception—if the Author or Typist does not have rights to the Matter, 
they cannot alter the document’s Profile even though they have full 
access to the document. This is because the document’s Profile is 
attached to the Matter in which they have no access. This means that 
the Author or Typist cannot change the document’s security, the 
document’s name, the Author, and other fields on the Document 
Profile form; however, they can change the Matter to one in which they 
do have access. Changing the Matter automatically moves the 
document to the different Matter.

If the ALL MATTERS node has been set, all Matters will appear in the 
ALL MATTERS node in the Dynamic View tree, even if the user does 
not have rights to the Matter. When a user clicks a Matter that he/she 
does not have appropriate access rights to, the following error message 
appears: “You do not have sufficient rights to subscribe to <MATTER 
NAME>.” 
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All Matters will appear in the Dynamic View/Dynamic Profile lookup 
windows, regardless of the matter security set.

The ALL MATTERS node is not a default setting. This must be set in the DVDP 
Configuration Tool in order to appear in the DVDP tree.

To define a Matter’s security:

1. Select a Matter in the Dynamic View tree.

2. Right-click the Matter and select Security.

3. In the Access Control List window, select the users and 
groups that should have access rights to the Matter.

Altering a Matter’s
Security

If a Matter’s security is altered, all document and folders related to that 
Matter re-inherit the new security, except for those documents where 
custom security is set. Ad-hoc subfolders created under a Matter also 
inherit the matter-security. 

Profiling Documents

During the profiling process, you can apply custom security or allow 
the document to inherit the Matter’s security. Applying custom security 
is performed by selecting the Use Custom Security check box; the DM 
Access Control List (ACL) interface appears, in which you assign users 
and/or groups the appropriate access rights. If this check box is not 
selected, the document automatically inherits the Matter’s security.
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Users can save documents only to Matters in which they have access 
rights. If a user attempts to save a document to a Matter that he/she 
does not have rights to, an error message will appear:  “You do not have 
sufficient rights to save to <MATTER NAME>.”

Profiling Ad-Hoc
Folders

When users create an ad-hoc folder within a Matter, the Matter’s 
security is automatically applied to the ad-hoc folder. There are two 
methods of creating an ad-hoc folder. 

The first method is right-clicking the enumeration and selecting the 
New Folder Here option. In this case, the user can only enter the folder’s 
name. In order to set custom security, the user must view the folder’s 
Profile form. 

The second method is to highlighting the enumeration and selecting 
the Folder>New Folder menu option. In this case, the Matter-Centric 
Profile form appears, in which the user can set security in addition to 
naming the folder.
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Subscribing

Users cannot subscribe to Matters in which they have no access rights; 
however, all Matters will appear in the Subscription lookup window, 
including those Matters in which the users do not have access. In this 
case, when users select a Matter they do not have access rights to, the 
following message appears: “You do not have sufficient rights to 
subscribe to <MATTER NAME>.”

If a user no longer has access to a Matter in which they had subscribed, 
the Matter will remain in the user's Subscription list until the user has 
unsubscribed from the Matter. When a user has documents already 
configured in DVDP, the user will still have access to these documents 
because he/she is the document’s Author and/or Typist. The Matter 
node will still be viewable to the user even if he/she does not have rights 
to the Matter. The user can make changes to the document, but he/she 
cannot alter the Profile form.

When users subscribe to a Client, all of the Client's Matters are included 
in the subscription, regardless if the user has access rights to all of the 
Matters.

Users can click the Subscribe to others option in the Subscription 
window; however, they cannot add a Matter subscription for another 
user who does not have access to the Matter.

Reassigning Documents to Different Matters

When a user reassigns a document or ad-hoc folder to another Matter 
by altering the Matter value on the Profile form, the new Matter’s 
security is reapplied. If the document had custom security applied, the 
Profile is reset to the Matter’s security and the new Matter’s security is 
applied. 

In the Configuration Tool, a global setting Keep Custom Security check 
box appears. If this check box is selected and if you have set custom 
security, the rights are maintained instead of being replaced.
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